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Legal notice

Copyright and trademark information relating to this product release.

Copyright © 2000–2024 RWS Holdings plc. All rights reserved.

This legal notice applies to RWS Holdings plc and its subsidiaries and affiliates. All intellectual
property rights contained herein are the sole and exclusive rights of RWS. All references to
RWS shall mean RWS Holdings plc and its subsidiaries and affiliates details of which can be
obtained upon written request.

All rights reserved. Unless explicitly stated otherwise, all intellectual property rights including
those in copyright in the content of this website and documentation are owned by or
controlled for these purposes by RWS. Except as otherwise expressly permitted hereunder
or in accordance with copyright legislation, the content of this site, and/or the documentation
may not be copied, reproduced, republished, downloaded, posted, broadcast or transmitted
in any way without the express written permission of RWS.

Trados Studio is a registered trademark of RWS. All other trademarks are the property of
their respective owners. The names of other companies and products mentioned herein may
be the trademarks of their respective owners. Unless stated to the contrary, no association
with any other company or product is intended or should be inferred.

This product may include open source or similar third-party software, details of which can
be found by clicking the following link: “Acknowledgments ”  on page 59 .

Although RWS takes all reasonable measures to provide accurate and comprehensive
information about the product, this information is provided as-is and all warranties,
conditions or other terms concerning the documentation whether express or implied by
statute, common law or otherwise (including those relating to satisfactory quality and fitness
for purposes) are excluded to the extent permitted by law.

To the maximum extent permitted by law, RWS shall not be liable in contract, tort (including
negligence or breach of statutory duty) or otherwise for any loss, injury, claim liability or
damage of any kind or arising out of, or in connection with, the use or performance of the
Software Documentation even if such losses and/or damages were foreseen, foreseeable or
known, for: (a) loss of, damage to or corruption of data, (b) economic loss, (c) loss of actual
or anticipated profits, (d) loss of business revenue, (e) loss of anticipated savings, (f) loss of
business, (g) loss of opportunity, (h) loss of goodwill, or (i) any indirect, special, incidental or
consequential loss or damage howsoever caused.

All Third Party Software is licensed "as is." RWS makes no warranties, express, implied,
statutory or otherwise with respect to the Third Party Software, and expressly disclaims all
implied warranties of non-infringement, merchantability and fitness for a particular purpose.
In no event will Licensor be liable for any damages, including loss of data, lost profits,
cost of cover or other special, incidental, consequential, direct, actual, general or
indirect damages arising from the use of the Third Party Software or accompanying
materials, however caused and on any theory of liability. This limitation will apply even
if Licensor has been advised of the possibility of such damage. The parties acknowledge
that this is a reasonable allocation of risk.

Information in this documentation, including any URL and other Internet website references,
is subject to change without notice. Without limiting the rights under copyright, no part of
this may be reproduced, stored in or introduced into a retrieval system, or transmitted in any
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form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or
for any purpose, without the express written permission of RWS.
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1

About this Quick Start Guide



This guide is for Trados users that want to leverage the cloud capabilities of the Trados
product family. It focuses on the how to create and set up your cloud project, going through
the whole cloud onboarding process.

Cloud references
In this guide, the term "cloud" covers all Trados product offerings powered by our cloud
platform:

• Trados Studio's cloud capabilities (formerly known as Trados Live Essential)

• Trados Team

• Trados Accelerate

• Trados Enterprise

• Trados Terminology

However, all the examples illustrate working with cloud projects using a cloud account with
Trados Studio's built in cloud capabilities.

Reference info
Who is this guide for and what does it cover?
This guide is for project managers. It focuses on the project lifecycle, starting with creating
a project and then managing that project through the use of packages in both local and cloud
workflows.

Project management refers to all operations involved in a project lifecycle, which includes:

• Project creation

• Project translation

• Project reporting

• Project monitoring

• Project delivery

This guide covers the basics for the three major project workflows:

• Local workflow - all aspects of project management are done from within Trados Studio

• Cloud workflow - you can manage projects in the cloud exclusively or in conjuction with
Trados Studio

• Server workflow - project management is done in collaboration with Trados GroupShare.

For more in-depth information about Trados Studio integration workflows, see Trados Studio
integration workflows in the online help.

1 About this Quick Start Guide
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How to use this guide

You can use the sample files to complete the exercises. Each
exercise builds on the last so if you are using the sample files you
need to follow through the instructions step-by-step.

This symbol indicates there are sample files available to complete
the exercise and their location. The paths specified are based on a
Microsoft Windows 10 or later operating system.

Note This indicates that there is a tip providing additional information
on the task you are performing.

Keyboard shortcuts This symbol indicates that there is an important piece of
information you need to know for the task you are performing.
Any keys that you need to press on your keyboard are displayed in
the following font: Ctrl+Enter.

Other information sources
Here are some other sources of information you can access:

• Trados Studio 2024 Help 

• Trados GroupShare Help 

• Trados GroupShare Installation Guide 

• Trados Studio 2024 Migration Guide 

• Translating and Reviewing Documents Quick Start Guide 

• Translation Memory Management Quick Start Guide 

• Trados Studio's built in cloud capabilities documentation 

• Trados Team documentation 

• Language Cloud Translation Management documentation 

Project concepts
Before you create a project, review the project concepts below.

1About this Quick Start Guide
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Concept Description

Language pairs A source language and a target language (language into which you
are translating). Some resources and settings can be selected for
use across all language pairs, for example termbases which are
multilingual. Translation memories and AutoSuggest dictionaries
are selected for a specific language pair as they are bilingual.
However, you can define the settings of a translation memory for
all language pairs.

For example, you could specify 70% as the minimum match value
for fuzzy matches at the All Language Pairs level. This setting is
then applied to every translation memory selected for each
language pair.

Project All files are translated and managed as part of a project. A project
may contain a single file or many files for translation into one
language or several languages. It may also contain reference
material, translation memories, termbases, AutoSuggest
dictionaries and instructions for translators.

Once a project has been created, the project manager can manage
all aspects of project effort and monitor project progress using the
project management tools in Trados Studio.

Cloud project A cloud project is a translation project published on cloud, the
translation productivity cloud from RWS. Cloud projects enable you
to upload your TMs and termbases into your own secure cloud
space and use them in Studio, along with cloud-based neural
machine translation.

Project package A project package is a file structure which contains all the files that
need to be sent to a project team member to enable them to
commence work on the project. For example, files to be translated
or reviewed.

Once the project package is created, you can send it by email, post
on an FTP site or use any other method that you prefer to send it
to the team member who will be working on the project files. This
eliminates the need to send multiple files or multiple emails and
enables all project information to be sent with project files in a
coherent structure.

Return packages A return package contains project files for which a specific manual
task has been completed. For example, project files that have been
translated or reviewed. It can also contain files for which further
work needs to be completed. For example, a reviewer may want to
return a translated file because of an incorrect translation which
the translator needs to fix.

When you create a return package it only includes the project files
and not the translation memory, termbases or AutoSuggest
dictionaries.

1 About this Quick Start Guide
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Concept Description

PerfectMatch A PerfectMatch is a form of context match that compares updated
source files to a corresponding set of existing bilingual documents
rather than to a translation memory. Segment matches, known as
PerfectMatches, are checked for context, that is, the surrounding
entries are checked to ensure that they are the same. They are
then extracted from the existing bilingual documents and
transferred to the updated source files. Because the PerfectMatch
segment matching process includes a check for context,
PerfectMatch units typically need no further translation or editing
during translation.

Batch task A task is a process that is performed on an individual file or on a
group of files (for example, an entire project). Batch tasks are
performed by the system. For example, the Word Count batch task
performs a word count for selected files and the word count
results can be seen in the Trados Studio views and reports. Batch
tasks can be put into a task sequence. All tasks in the sequence are
performed (in the order in which they appear in the sequence) on
all selected tasks.

Task sequence A task sequence contains multiple batch tasks. When you run a
task sequence, all tasks in the sequence are performed on all
selected files: the tasks are performed in the order in which they
appear in the sequence. A number of batch task sequences are
provided for you and if you have the Professional version you can
also create new ones.

1About this Quick Start Guide
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2

About Trados Studio



Trados Studio enables organizations to effectively manage all aspects of their translation
projects. Trados Studio incorporates project management and computer-aided translation
(CAT) tools for use by project managers, translators, editors, proofreaders and other
language professionals. These tools are provided through a highly customizable user
interface and it is easy to add on features from the RWS AppStore.

Workflows overview
The Trados translation tool set was created with flexibility in mind. Because of this, you have
the option to combine offline workflows in Trados Studio and online workflows in the cloud
in any manner that you see fit.

This section offers an overview of commonly used project workflows, although you can mix
and match any aspect of the following scenarios to meet your own project's needs.

Local only workflows

• Single-file translation workflow: This is an example of a workflow for translating a file.
This simply allows you to translate, verify and then generate your translated document.
If this is your first time using Trados Studio , you should specify your settings, translation
memories, AutoSuggest dictionaries and termbases before you start.

• Project package translation workflow: The project package translation workflow is an
offline workflow in which project work is distributed among team members for
translation, review and final submission. This is an example of one way in which you can
work with projects through the use of project packages.

The following diagram shows a possible workflow when translating a single file:

2 About Trados Studio
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The following diagram shows a possible workflow when working with project packages:

2About Trados Studio
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Cloud only workflows
In this workflow you can create, translate and review cloud projects directly from a browser.

The work required for creating and working on a cloud project is controlled by workflows
and divided into tasks. Workflows control which cloud project tasks are executed in which
order, and specify the users, groups or vendors assigned for each task.

You might prefer working with cloud projects from a browser if you are using a MAC or a
tablet where you cannot install Trados Studio.

The following diagram shows a potential workflow when working with cloud projects:

2 About Trados Studio
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Mixed workflows
In complex scenarios, Project Managers may need to coordinate and split the work among
users of Trados Studio or the cloud.

In this workflow you have the option to:

• Create a local project from Trados Studio and later save it to the cloud.

• Create a cloud project directly from Trados Studio.

• Create a cloud project from a browser and later sync it with Trados Studio.

Once a project is linked between the two platforms, all the changes made on either platform
are automatically synced to the cloud. This allows you to move seamlessly between the
two.

Server workflows
The server project translation workflow is an online workflow in which project work is
published on the Trados GroupShare server. This is an example of one way in which you can
work with a shared project you start in Trados Studio.

Project Managers assign work, resources and users to various phases. When the work
reaches a particular phase, the user assigned to that phase (translator or reviewer) is
automatically given access and permission to work.

2About Trados Studio
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3

Manage local projects



Project settings
There is a multitude of settings that you can customize to improve Trados Studio behavior
or adapt it to your needs.

This guide covers the basic settings you can leverage to improve translation efficiency. For
more information about customizing Trados Studio functionality see Preferences and defaults
 in the online help.

Language pairs
A language pair is used to store settings relating to translation from a specific source
language into a specific target language. Resources and options are typically configured for
use across all language pairs to which they apply. Multilingual resources, such as termbases
and server-based translation memories, may apply to more than one language pair. Bilingual
resources, such as file-based translation memories, only apply to a specific language pair.

You may want to set up these default settings prior to translating documents. This allows you
to use the same settings and resources for all your translations. For example, you may
want to specify which translation memory, termbase and other resources to use to translate
from English to German.

For example, if you always have translation projects that are translated from English to
German, you may want to specify which translation memory, termbase and other resources
to use.

Options dialog
You can define default settings for use in your translation projects in the Options dialog.
When you define settings here, it automatically updates the default project template which
you can then select when creating your project. The default project template is stored :

Documents\Studio 2024\Projects\Samples\Project Templates\Default.sdltpl

Alternatively, you can use project templates to define your settings for customers for
whom you need to create several projects. Select File > Setup > Project Template from the
Ribbon to create a template.

All Language Pairs
Typically, you configure translation resources (even if they are bilingual) and edit settings at
the All Language Pairs level. The settings then apply to all language pairs and the
translation resources apply to the all language pairs to which they are relevant.

For example:

• If you select a multilingual server-based translation memory at the All Language Pairs
level that contains English to German and English to French language pairs, this

3 Manage local projects
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translation memory is automatically selected for English to German and English to
French projects.

• If you change the minimum match value to 65% at the All Language Pairs level, it will
apply to all language pairs.

Individual exceptions to these settings can be defined for each language pair. For
example, if you wanted the English to German language pair to have a different minimum
match value, you could change it at the individual language pair level.

Resources
You can select the following resources for a language pair:

3Manage local projects
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Resource Description

Translation
memories

The Trados Studio translation memory file-based format is
*.sdltm. You can use translation memories from any version of
Trados Studio 2009 and later. If you have a translation memory
from a previous version of SDL Trados or SDLX, refer to the Trados
Studio 2024 Migration Guide for details of how to upgrade the
translation memory to the current format.

You can also connect to server-based translation memories from
Trados GroupShare 2017-2020.

To connect to WorldServer 11.x and 10.4.5 Live TM, go to the
Add-instab >RWS AppStore and install the free WorldServer
Compatibility Pack for Studio.

Neural machine
translation providers

Trados Studio can connect to Language Weaver via Trados Team to
generate automated translations. You can access many other
Automated Translation providers, including Google Cloud
Translation and DeepL, from the RWS AppStore.

To find and install third-party AT providers, go to the Add-ins tab >
RWS AppStore and search for apps in the Automated Translation
category.

You can also add your own custom automated translation server.

Termbases Trados Studio 2024 is compatible with file-based termbases
created in MultiTerm 2017 and later. In addition, you can use the
following legacy termbase formats:
• MultiTerm 2007 (version 7.5) and previous 7.x releases
• MultiTerm iX (version 6.x).

When you open legacy termbases, they are automatically
upgraded to MultiTerm 2024, *.sdltb format. You can also
connect to server-based termbases in Trados GroupShare 2017
and later.

A convenient way of adding terminology assets to your project is
using termbases in your Trados Team account. If you have these
configured in your Trados Team account, you can use them just
like any other termbase.

AutoSuggest
dictionaries

AutoSuggest editing is an important feature which can be used to
speed up manual translation. AutoSuggest monitors what you are
typing. After you have typed the first few characters of a word,
AutoSuggest presents you with a list of suggested words and
phrases from the translation memory in the target language that
start with the same characters. You can use the following as
sources for AutoSuggest:
• AutoSuggest dictionaries - create a new or select an existing

AutoSuggest dictionary created by yourself or another user.
This dictionary contains words and phrases extracted from
translation memories (*.sdltm) or *.tmx files.

• A MultiTerm termbase selected in your project.
• AutoText entries - create a list of words and phrases manually

by typing them into Trados Studio.

3 Manage local projects
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The AnyTM translation providers for local TMs, server-based TMs and machine translation
providers allow you to leverage translations from TMs with different source or target
language than the ones you have set in your project.

Defining your default language pair settings
Before starting to translate local projects, you may want to set up default language pair
settings. This allows you to use the same settings and resources for all your local translations.
For example, you may want to specify which translation memory, termbase and other
resources to use to translate local projects from English to German.

About this task

Follow these instructions to set up your default translation memories, termbases and
AutoSuggest dictionaries for translating from English (United States) to German (Germany).

Note: These settings should be defined at the All Language Pairs level where possible.

You can follow the same procedure for setting up default resources for other language
pairs. In this example, you will use the sample project in Trados Studio. Once you are familiar
with these steps, you can then use them to specify your own default resources for all
language pairs with which you are working.

Procedure
1. Select File > Options from the Ribbon. The Options dialog is displayed.
2. Select Language Pairs > All Language Pairs > Translation Memory and Automated

Translation from the navigation tree.
3. On the Translation Memory and Automated Translation page, you can select file-based

and server-based translation memories. Select Use > File-based Translation Memory
and browse for the sample translation memory file.

…Documents\Studio 2024\Projects\Samples\SampleProject\TMs\English-German.
sdltm

• If your setup does not include any default options for the language pair English
(United States) - German (Germany), the Add Supported Language Pairs dialog is
displayed. Select the check box next to the language pair and click OK.

3Manage local projects
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4. Select Language Pairs > All Language Pairs > Termbases from the navigation tree.
5. On the Termbases page, you can select MultiTerm termbases. Select Use > File-based

MultiTerm Termbase and browse for the sample termbase file.
…Documents\Studio 2024\Projects\Samples\SampleProject\Termbase\

Printer.sdltb

6. Select Language Pairs > English (United States) - German (Germany) >
AutoSuggest Dictionaries from the navigation tree.

Note: AutoSuggest dictionaries can only be defined at the individual language pair
level.

3 Manage local projects
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7. On the AutoSuggest Dictionaries page, you can select AutoSuggest dictionaries. Select
Add and browse for the sample AutoSuggest dictionary file.

…Documents\Studio 2024\Projects\Samples\SampleProject\AutoSuggest\
AutoSuggest_EN-US_DE-DE.bpm

8. Select OK to save your default settings.
These resources will now be used whenever you translate a document from English to
German.

Click through the tree structure under All Language Pairs to define additional
settings, such as minimum fuzzy match values and autosubstitution. Remember these
settings will apply to all of the language pairs. If you want to specify settings that are only
specific to the English to German language pair, do this under Language Pairs >
(English United States) - German (Germany).

Creating projects
Let us assume that you have been asked by a customer to translate a group of files from
English to German.

You translate the files as part of a local or a cloud project. Projects enable you to:

• Produce translation analysis figures for viewing on screen in Trados Studio and in
reports.

• Convert project files to *.sdlxliff format.

• Pre-translate project files by applying translations from translation memories.

• Create a project translation memories.

If you do not select a task to be performed during project creation, you can perform that
task after the project is created. For example, you may initially only want to analyze files

3Manage local projects

19Project Management



when you create a project in order to get analysis figures to provide a quote for a customer.

Creating a local project
Create a translation project that you can work with and save locally, on your computer.

About this task
If you want to work with online projects instead, you can either:

• create cloud projects in the cloud, in your own secure cloud account. For information on
cloud projects, see the “Creating a cloud project ” on page 42 section in this guide.

• publish local projects on an Trados GroupShare server. For information on Trados
GroupShare projects, see the videos and information in the Trados Studio Help .

• save local projects to cloud. For information on how to do that, see Save local projects
to cloud .

You can create new local projects either from Projects view > New Project > New Local
Project, from the Welcome view where you can drag and drop your translation files, or from
the Manager view > Add Project > New Project. The Create a New Project wizard takes
you through all the steps needed to create a translation project.

Procedure
1. Go to the Welcome view and drag the following files to translate on the Welcome screen:

• SamplePhotoPrinter.doc

• SamplePresentation.pptx

• SecondSample.docx

• TryPerfectMatch.doc
…Documents\Studio 2024\Projects\Samples\SampleProject\en-US

2. In the Translate dialog, select Create new project.
3. In the Use Settings from drop-down list on the first page of the Create a New Project

wizard, if not already selected, select the Default project template. The default project
template is updated with your default settings and the resources you defined in the
Options dialog.

…Documents\Studio 2024\Projects\Samples\Project Templates\Default.sdltpl

3 Manage local projects
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4. Fill in a project name (e.g. Sample EN-DE). The project is automatically saved to the
…Documents\Studio 2024\Projects folder. Leave the default location.

5. You are now ready to create your project with the One Step workflow. However, you can
further customize the project settings by going through the other pages of the Create
New Project wizard.

• Select Finish to start the project creation and jump to the Summary page of the
Create New Project wizard.

• Select Next to further customize your project settings.

Specifying project details
Procedure
1. In the General wizard page, fill in a Project Description.
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2. Click Customers and create RWS as a customer.
a. Fill in the Name - "RWS"
b. Fill in the Email - for example "rws@rws.com"
c. Click the icon.

3. Select RWS from the Customer drop-down list.
4. Click Next.

Selecting termbases
On the Termbases page, the termbase you selected when you set up your default options is
automatically selected for this project.

About this task
…Documents\Studio 2024\Projects\Samples\SampleProject\Termbase\Printer.sdltb

Note: You can add multiple termbases.
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Procedure
1. Add other termbases to your project (see the Translating and reviewing documents quick

start guide).
2. Select Next.

Selecting translation memories
In the Translation resources page, the translation memory you selected when you set up
your default options is automatically selected for this project.

About this task
…Documents\Studio 2024\Projects\Samples\SampleProject\TMs\English-German.

sdltm

Note: You can add multiple translation memories and also connect to automated translation
servers (machine translation).
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Procedure
1. Add other translation resources to your project (see the Translating and reviewing

documents guide).
2. Select Next.

Reusing previously translated documents to
apply PerfectMatch
On the PerfectMatch page, you can select previously translated documents to be used for
PerfectMatch.

PerfectMatch allows you to transfer the translations from the previous set of *.sdlxliff,
SDL Edit (ITD) or Tradostag (TTX) bilingual documents to the new project files.

Note: Your license for Trados Studio may or may not include this feature. See the About
Editions and Licensing topic in the Trados Studio 2024 Help for information about your license
features.
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Why should you use PerfectMatch?
There are two main scenarios when you can leverage previous translations by applying
PerfectMatch. For a list of additional scenarios, see the Trados Studio 2024 Help .

Pre-Project scenario
At the start of a project, you can base a new project on an existing project that has been
fully reviewed. This will use the translated documents from the previous project for
PerfectMatch. This could be useful, for example, if you are starting translation on a technical
manual for a second version of a product where the product is almost the same as the first
version.

Mid-Project scenario
If you are part of the way through translating a project and you receive a new set of source
files that have been slightly modified, you can use PerfectMatch to easily apply the work you
have already translated to the new set of documents. This can be accomplished by creating
a new project with the new set of files and basing it on the project you are in the middle of
translating. PerfectMatch will then automatically apply all of your existing work to the new
set of files.

1. New project files
2. Previously translated documents
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Assume that the SamplePhotoPrinter.doc has a version 1 of the document that was fully
translated and reviewed in a previous project.

SamplePhotoPrinter-Version1.doc

This means that all segments are translated and reviewed.

In your current project, you have selected version 2 of this document which has some
additional text that has been added for this release.

SamplePhotoPrinter-Version2.doc
About this task

Since the document is primarily the same as the previous document, you can extract the
translations from the previous document and transfer them to the new version of the
document as PerfectMatches.

Procedure
1. On the PerfectMatch page, select the previous document to use for PerfectMatch:

• Click Add and select Specific Previous Document from the drop-down list.

• Select the previously translated version of the document.
The previously translated version of the sample document is not included in the

Trados Studio sample documents. However, you can see the results of applying
PerfectMatch on the next page.
Since the previous document had been fully translated and reviewed, any
translations that are transferred to the new project file do not need any further
translation or review.

2. To indicate that no further work is needed on the transferred translations, select to
Lock segments after matching.
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Selecting this option will transfer all of the translations to new document with the
following displayed in the Segment Status column:

• - Indicates that the match type is PerfectMatch.

• - Indicates that the segment status is Signed off. This means that the translations
need no further translation or review.

• - Indicates the translations are locked. This avoids anyone accidentally editing
them since no further work is needed.

To see the results, open TryPerfectMatch. doc.xliff from the Sample Project in the
Editor.

3. Return to the New Project wizard and click Next on the PerfectMatch page.

Results of applying PerfectMatch

Selecting tasks and task settings
On the Project Preparation page, you select the preparation steps that you want to be
performed on the files in the newly created project.

The task sequence contains batch tasks that prepare your project files.

Default task sequence
Depending on which edition of Trados Studio you are using, a different task sequence is
selected by default:

• Prepare

• Prepare without Project TM
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Both of these task sequences prepare the files for translation by converting them to the
bilingual *.sdlxliff format, pre-translating them and analyzing them. The only difference
is that the Prepare without Project TM does not create a project translation memory.

Note: A project translation memory contains translations that have been taken from the
main translation memories that you selected for a project. Only translations where there is
a degree of match that at least meets the minimum match requirement you have specified
will be retrieved into the project translation memory.

Why use the Prepare task sequence?
You may want to use this task sequence to create a project translation memory if you do not
want translators updating the main translation memory during translation but still want to
allow them to leverage translations from one document to another or from other translators
working on the same project.

Why use the Prepare without Project TM task sequence?
You may want to use this task sequence that does not create a project translation memory if
you are a freelance translator and you want to update the main translation memory during
translation instead of the project translation memory.

About this task
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Procedure
1. If necessary, select the Prepare task sequence from the Task Sequence drop-down list

and then click Next.

The Batch Processing Settings page is displayed. On this page, you specify batch
processing settings. These settings are applied when the tasks selected on the Project
Preparation page are performed.

The settings available are determined by the batch tasks you chose on the previous
page. For example, Analyze Files is selected on the previous page and therefore is one
of the options on the navigation tree on this page.

2. Select the Project Translation Memories page. On this page you can specify if you want
the project translation memory to be created as file-based on your computer or on a
server that translators can connect to at the same time.

3. Keep the default settings to create the project translation memory as file-based and
click Finish.

4. The Preparing Project page is displayed while your project is being created. Progress
bars indicate what task the process has reached.

5. When all of the tasks have been completed, click Close to close the New Project wizard.
The project you created, Sample EN-DE, is automatically opened in Trados Studio and
becomes the active project.
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Active project
You can have several projects listed in the Projects view at the same time. However, only one
of these can be open in Trados Studio at any time and this project is known as the active
project. When you created a project in the last exercise it automatically became the active
project.

• The name of the active project is displayed on the title bar of the application.

• The files for the project are displayed in the Files view.

• The reports that have been generated for that project are displayed in the Reports
view.

Translation file status
Procedure
1. Click the Files button in the navigation pane to display the Files view.

All of the files that you added to the project are listed here. They all have a status of In
Translation.

2. Click on the different files and select the Confirmation Statistics tab at the bottom of
the screen to see how many segments were translated during pre-translation.
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Work with local project packages
You can send translation or review work to another Trados Studio user, by creating project
packages in an offline workflow. You must first open the package in Trados Studio to update
the files or to access the files for translation or review.

Packages contain files that you need to translate or review, or files that have been translated
and reviewed.

Opening a project packages enables you to receive all files for translation or review, and all
related files. Once you have opened a package in Trados Studio, the files, translation
memories, termbases and AutoSuggest dictionaries included in the package are immediately
available to be used. When you receive a project package from your project manager, save
the package to a suitable location.

Project package
A project package is a single zipped file that contains all of the files that need to be sent to a
project team member in order for them to commence work on the project.

It can contain:

• Project files: Bilingual SDL XLIFF files and reference files

• The project translation memory

• File-based termbases, translation memories and AutoSuggest dictionaries

• Connection details for server-based translation memories, server-based termbases or
automated translation providers

• Project settings

Return package
A return package contains project files for which a specific manual task has been completed.
For example, project files that have been translated or reviewed. It can also contain files for
which further work needs to be completed. For example, a reviewer may want to return a
translated file because of an incorrect translation which the translator needs to fix.

When you create a return package it only includes the project files and not the translation
memory, termbases or AutoSuggest dictionaries.
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Recommended package use
There are two recommendations about how you work with packages in your workflow:

• Always create a package for every task you want to be completed.

• Always create a return package for every task you have completed and send to the
person who gave you the task.

Creating a package for a local project
After creating a local project, the next step is to create a project package. Then you can send
it to a translator so that they can translate the files it contains and use the resources that
you selected during project creation to assist the translation.

About this task
…Documents\Studio 2024\Translation Memories\Sample EN-DE.sdltm (This is the project

you created in the last section.)

Procedure
1. Select the three files in the local project in the Files view and right-click and select Create

Project Package from the shortcut menu. You can also select Create Project Package
from on Home tab.

2. The Create Project Package wizard is displayed on the Select Files page. Select Next to
include all three files in the package.
The Project Package Options page is displayed. On this page, specify where you want to
save the project package and if you want to create one package or to split the files
into multiple packages.
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3. Leave the default selections on this page and select Next:

• The package is saved to Documents/Studio 2024/Projects by default.

• One project package is created containing all three files.
If your project has more than one language, you can choose to create a package

for every project language and then send each package to the appropriate
translator.
You can also further split a package by the number of words that have not yet been
translated. This allows you to assign the work for one language pair to multiple
translators.
The Review Project Packages page is displayed.
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4. Assign the work of translating these files to a user:

• Select Users next to the Assign To box.

• Create a user called Tom Translator with a description of EN-DE Translator.

• Select Tom Translator from the Assign To drop-down list.
5. Since the files you are sending need to be translated, ensure that Translate is selected

from the Task drop-down list.

If you were sending files for review, you can select the Review task or any custom
tasks that you want to create.

6. In the Comment box, enter the following instructions for Tom Translator:
Please translate these files and then send them in a project package to Ralph Reviewer.
When you receive the reviewed files in a return package, open the package in Trados
Studio and then create a new return package to send to me (project manager).

7. Select Next.
8. The Additional Options page is displayed. On this page, specify other resources to be

included in the package:

• Project Translation Memory: Leave the default selection, Create a new file-based
project translation memory for every package. The new project translation
memory contains information only relevant to the files in the package.
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You might want to select this option if the contents of the package are small
compared to the project itself. Including the entire project translation memory for a
large project would create large packages.

• File-based Resources: Select the AutoSuggest dictionaries check box and
Termbases check box to include these resources from the project in the package.

• Select Finish.

Note: For information about all of the options on this page, see the Trados Studio
2024 Help .

9. The Creating Packages page is displayed. On this page, the packages are created and
you can choose to send the project packages by:

• Email to the appropriate team members by selecting Send Packages by Email.

• Another method such as placing it on an FTP site. Select Open Target Folder to
open the folder where your return package is saved.

10. Select Close.
Assume that the package has now been sent to the translator. When the translator
opens the package, all of the resources included are automatically opened during
translation.

Opening a return package
Assume that the translator (Tom Translator) has completed the translation and that the
reviewer (Ralph Reviewer) has approved all of the translations. You receive a return package
from Tom Translator containing the translated and reviewed project files.

Procedure
1. To open the return package:
2. Select Open Package on Home tab when you are in the Projects view. The Open

Package wizard is displayed.
3. Select the return package and click Open. The Open Package wizard opens on the Review

Package Contents page.

You cannot import the return package content into the project that you have not
created yourself.
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4. Review the package details and select folders from the bottom left-hand pane to view
the files within that folder in the bottom-right hand pane.

5. Select Finish to import the package. The Importing Package page is displayed.
6. When the import is complete, select Close.

The corresponding project is updated with the completed manual task information in
Trados Studio.

Tracking project status
Some reports are automatically generated during project creation. For example, the Analyze
Files report is always created. Depending on which tasks you choose to perform
pre-translation or apply PerfectMatch during project creation, the Pre-translated Files and
Apply PerfectMatch reports are also generated.

At any time during a project's lifecycle, you can use batch tasks to generate updated or new
reports that give you information about the status of the translations in a project. You may
want to do this after you have received completed work in a return package.

The Translation Count report provides details about the status of the translations in a
project. For example, the status may be Translated or Translation Approved. This is useful
if you want to view the progress of the translation project.

You can also check project progress in the Manager view, Files view and File view windows:
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Generating a report
Generate the Translation Count report for the Sample EN-DE.sdlproj project you created:

About this task
…Documents\Studio 2024\Projects\Sample EN-DE\Sample EN-DE.sdlproj

Procedure
1. In Manageror Projects view select Batch Tasks > Translation Count on the Home

tab.
2. On the Batch Tasks page of the Batch Processing wizard select Next.
3. All files for the active project are listed on the Files page. Select Next. The Settings page

is displayed.
4. There are no settings that you need to specify to perform this batch task. Click Finish to

generate the report. The Performing Tasks page is displayed. When the task is complete,
the Translation Count report can be viewed in the Reports view.

5. Display the report by closing the wizard and displaying the Reports view or by clicking
Task Results and selecting to view the report from the Task Results dialog box.
The report data is split into three parts:

• Summary: This displays a summary of information, for example, the project name
and how many files on which this report is based.

• Totals: This displays status information about all files on which the report is based.

• File Details: This displays information per file. Since this project has three files, they
each have a section indicating the status of their translations.

3Manage local projects

37Project Management



Finalizing local project files
Assume that all the files in the project have now been translated and reviewed. The next
step is to finalize your files. To finalize files, perform the following tasks:

About this task

• Update Main Translation Memories to update the English-German.sdltm translation
memory that was added to your project. This does not update the project translation
memory that was created when the project was created.

• Generate Target Translations to convert the *.sdlxliff files back to their original
formats and places them into the German language subfolder.
...Documents\Studio 2024\Projects\Samples\SampleProject

Procedure
1. In Manager or Projects view select Batch Tasks > Finalize from the Home tab. The

Batch Processing wizard is displayed on the Batch Tasks page.
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2. Click Next. The Files page is displayed. All files for the active project are listed here.
3. Click Next. The Settings page is displayed.
4. Select All Language Pairs > Batch Processing > Translation Memory Updates from

the navigation tree. This page shows the status that the translations must have in order
for them to be added to the main translation memory. By default, only translations that
have a status of Translated, Translation Approved or Signed Off are added to the
main translation memory. In the If target segments differ section, select how Trados
Studio treats new translation units that have the same source segment as an existing
translation unit.

5. Assume that you only want translations that have been reviewed to be added to the
translation memory. Clear the check box next to Translated. When the batch task is
performed, only translations that have been reviewed and approved update the
translation memory.
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6. Click Finish to update the main translation memory and generate the target translated
files. The Performing tasks page is displayed.

7. Click Close when the tasks have finished. The files in the Files view have now been
converted back to their original formats and are no longer listed as *.sdlxliff files.

8. Select a file in the Files view and right-click and select Explore Containing Folder from
the shortcut menu. Your translated files are placed in the German language subfolder
de-DE of your project and saved with their original file names. This is the same folder that
also contains the *.sdlxliff bilingual files.
Your project is now complete and the translated files can be given to the customer.
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Manage cloud projects



Prerequisites for working with cloud
projects
With the free Trados Studio's cloud capabilities subscription, you create your own cloud
projects that you can then translate in the Editor view or in the Online Editor. This helps you
familiarize yourself with working on cloud projects using both your desktop as well as an
online editing environment, depending on your needs and project flows.

The following section of this quick start guide assumes you have read and completed the
"Cloud onboarding Quick StartGuide " or you already have an onboarded cloud account.

If you don't have an onboarded cloud account see " Onboarding your cloud account ".

Cloud references
In this guide, the term "cloud" covers all Trados offerings powered by RWS Language Cloud:

• Trados Studio's cloud capabilities (formerly known as Trados Live Essential)

• Trados Team

• Trados Accelerate

• Trados Enterprise

• Trados Terminology

All the examples illustrate working with cloud projects using a cloud account with Trados
Studio's cloud capabilities.

Create a cloud project
You can create, translate and review cloud projects both from Trados Studio and from a
browser. Because your work is synced to the cloud, you can move seamlessly between the
two.

You might prefer working with cloud projects from Trados Studio if you are multitasking on
local and cloud projects and do not want to switch applications. Trados Studio also enables
you to work on cloud projects without an internet connection as it syncs any offline changes
to the cloud when you get back online.

Creating cloud projects from a browser
To create a new cloud project from a browser:
1. Once you are logged in into your account from a browser, click Projects > + New Project

to display the cloud project creation wizard from the browser.
2. Add the general project details: Name, Due date and an optional Description.

In this example, we are creating a new project with the sample files shipped with Trados
Studio:
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3. Add the project files from ...Documents\Studio 2024\Projects\Samples\SampleProject/en-us.
Trados automatically identifies the files as Translatable or Reference, according to
specifications of your selected file type configuration. In the Usage column, you can
change which files are translatable and which ones should be used as reference only.

4. Select the location in your cloud account where you want to save the new project.
5. Select a project template to pre-fill the project settings and cloud resources from the

template.
6. Click Next to go to the Translation Engine page to add an engine if you do not have

one specified in the project template.
If you are logged in as an Administrator, Project Manager or Lead Project Manager with
a Trados Team, Trados Enterprise or Trados Accelerate subscription, the wizard also
displays the Workflow page. Administrators and Lead Project Managers with a Trados
Enterprise or Trados Accelerate subscription also see the Pricing Models page before the
Summary page.

7. Click Create and Start to finalize creating the new project with default settings, or click
Next to specify the TM and verification settings for your project. You can also change
these project settings after creating the project.
Most of these project settings can also be edited when opening the project in Trados
Studio. However, Penalties, Filter Penalties, Field values and Verification settings for cloud
projects are read-only in Trados Studio. These settings can only be edited when
accessing your Cloud account from a browser, in the Settings > Configuration area of
the selected project.

For more information on creating cloud projects from a browser see the "Project creation"
topic in the Trados Studio's cloud capabilities documentation .
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Creating cloud projects from Trados Studio
You can create cloud projects both from Trados Studio and from a browser. You might prefer
creating cloud projects from Trados Studio when you plan to start translating or reviewing
in Studio's Editor view right away and you want to use a simpler workflow.

To create cloud accounts, make sure you have already onboarded your cloud account as
explained in the section Prerequisite: Onboard your cloud account.
1. Select New Project > New Cloud Project or press Ctrl+Alt+N. Trados Studio displays

the Create New Language Cloud Project on the General page.
2. Enter a name for your project. The maximum length for project names is 50 characters.
3. Select a date and time by which the project must be completed.
4. In the Location field, select the folder in your cloud account where you want to store

the project. For this exercise, you can use Globex if you have completed the Onboarding
Quick Start Guide or create a new customer.

5. Optionally, select a template available in the location that you have specified for your
project above.

6. From the File Type Configuration list, select an existing configuration available in the
selected location. Custom configurations enables you to specify exactly the type of files
that can be processed as translatable files, and the type of text that can be extracted from
the files.
In this example, we are using the Template for Sample Resources created in the previous
section which automatically adds the configuration included in the template:

7. Add the project files. Click Add Files to add individual files. To add a set of files, drag a
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folder or an archive. For *.sdlxliff files, the source and target languages are automatically
detected when the files are added.

8. In the Usage column, specify which files are Translatable and which ones should be
used as Reference only. Trados Studio automatically identifies the files as Translatable
or Reference, according to specifications of your selected file type configuration.

9. Specify one Source Language and one or more Target Languages for your project.
The language fields are pre-populated with the default languages specified under File >
Options > Editor > Languages.

10. In the Description box, enter some relevant details about your project. The maximum
description length is 200 characters.

11. Click Next to go to the Translation Resources page and select a translation engine to
use for your project. cloud translation engines include translation memories, termbases
and Neural Machine Translation.

12. Select an existing translation engine available in your cloud account.
In this example, we are adding the sample engine created in the previous section. This
automatically applies the translation resources and the language processing rule
available in the engine.

The resources available in the selected translation engine are not editable. However,
you can add additional, local translation resources when you download the project in
Trados Studio and go to Project Settings.

13. Click Next to go to the Summary page of the wizard and consult the project details. If
you are logged in as an Administrator, Project Manager or Lead Project Manager with a
Trados Team, Trados Enterprise or a Trados Accelerate subscription, the wizard also
displays the Workflow page. Administrators and Lead Project Managers with a Trados
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Enterprise or Trados Accelerate subscription also see the Pricing Models page before
the Summary page.

14. Select Finish to create and start the new cloud project. Trados Studio uploads the project
to your cloud account and starts preparing the project files. The Notifications tab
shows a We are preparing your cloud project message in, on the right-hand side of the
screen.

You can also create a new cloud project from the Manager view under the Add Project
button, and then following the same steps as above.

Monitor project preparation
The processing of cloud project files is handled in the cloud. This frees all Trados Studio
resources for any local projects you might be working on in parallel.

Newly created cloud project are available in Trados Studio only after the cloud has finished
pre-processing the files. To monitor project preparation from Trados Studio:
1. In the Notifications tab, go to the We are preparing your cloud project message

displayed after you have finished creating the new cloud project.
2. Click Open in Language Cloud in this notification to check the project preparation in

the Stages tab.
3. Once the files have been pre-processed and have reached the first Translation, Linguistic

Review or Implement Customer Review task in the workflow. With a Trados Studio's
cloud capabilities subscription, the only manual task in the workflow is the Translation
task:
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When the files reach the Translation stage, Trados Studio displays the projects files in the
Files view. The new project is also immediately available in the Projects tab of your cloud
account.

You can now start translate or review either in the Online Editor or in Trados Studio's Editor
view.

For more information, see the Translating and reviewing Quick Start Guide .

Saving local projects to cloud
Saving local projects and project packages to cloud is useful if you want to you can tweak
your files locally or apply apps, PerfectMatch or NMT then you can upgrade them with cloud
capabilities such as automated translation workflows, access to the Online Editor, frequent
back-ups and syncing across devices.

Before you begin

Before you begin, make sure that you are logged into your cloud account.

About this task
To save your local project or project package to cloud:

Procedure
1. Select your project from the Projects view and click on Save to Cloud on the ribbon.

Alternatively, you can select your project, right-click on it and select Save to Cloud.
This displays the Save to Cloud wizard. You can also perform this action in the Manager
Viewby opening the kebab menu for your project and then clicking on Save to
Cloud.

2. On the first page of the wizard, configure the following:

• Choose a Project Name for your cloud project. By default, the wizard will
automatically complete the field with the name of the local project, but you are free
to choose your desired project name.

• In the Due drop-down menu, choose the project's due date. When saving project
packages to cloud, LC also adds a due date for each Human task in the cloud
workflow. The due dates for the tasks are estimated based on the time required to
complete the project by your specified due date. If you want, you can later edit the
due dates of these tasks to better suit your needs.

• In the Location field, select the folder in the cloud account where you want to save
your project. If you are logged in with an Administrator account, you can also click
New customer to create a new location in your cloud account.

• Select a Project Template previously configured in your cloud account. Project
templates give you control over how cloud translation resources are applied during
cloud pre-processing and also provide specific cloud quality checking settings.
Project templates can also be shared with your team, if you are part of one.

• Select one of the Translation Engines available on your cloud account. Translation
engines include translation memories, termbases and Neural Machine Translation.
Note that your Translation Engines need to contain at least one language pair
present in your project, otherwise they will not show up in the list.
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• If you have a Trados Enterprise subscription, you can also set a Pricing Model.
Pricing models determine price estimates for each project language and calculate
additional costs. If you are logged in with an Administrator or Lead Project Manager
you can also click + New Pricing model to go to your cloud account and add a
new one.

• Under Workflow, choose an existing workflow from your cloud account. If you are
logged in with an Administrator, Project Manager or Lead Project Manager you can
also click + New Workflow to go to your cloud account and add a new one.

3. Click Next.
This displays the Summary page. Here you can review your specifications.

4. Click Finish to complete the wizard and save your project to the cloud. Your project will
be grayed out and disabled until the process is complete. You can follow the progress by
checking the Notifications tab.

Working with project packages saved to cloud
You can leverage cloud functionality when working with project packages by saving them to
cloud. This creates a new project package type, which you can work on with your peers in
a browser.

Before you begin

Before you begin, make sure that you are logged into your cloud account. It is also important
that your project package includes the native files for each target bilingual files. If the native
files are embedded in the .xliff file, Trados Studio automatically extracts the native files
from the embedded content. If your native files are linked as dependency files, you will still
be able to save the package to cloud, but the Preview and Generate Target functions will not
work. If neither are available, you will not be able to save the project package to cloud.

About this task

Project package saved to cloud workflow

Procedure
1. Save your project package to cloud.

You will find your project package saved to cloud in the Projects view.
2. Work on it in Trados Studio, or select your package and click Open in Cloud to work on

it in a browser where you can use the Online Editor and customize your workflows to
collaborate with your peers.
Your work will be synchronized across platforms and devices. Any changes that your
peers make will be tracked both in Trados Studio and on the web application.

3. Once you complete your tasks, create a return package from the Trados Studio instance
that saved the project package to cloud by clicking Create Return Package.
Trados Studio will synchronize your local content with the cloud, since it creates return
packages based on the cloud version of the project package. Trados Studio completes
the return package with local data if you lose connection to Language Cloud or if you
cancel the synchronization.

4. Send the return package back to the package sender.
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Backing up your local project or project package
files
Trados Studio automatically creates a back-up of your local project or project package when
you save it to cloud. The backed-up project file will appear in the same path as the original
project file and will have the additional extension ".bkp".

About this task
To use your backup file

Procedure
1. Go to the project folder for the project backup you want to recover. Locate your project

file.
2. Delete the ".bkp" extension of the file.
3. Open Trados Studio, go to the Projects view, and click Open Project. Select the file as

usual.

Packages for cloud projects
Cloud project files are synced to your cloud account whenever you save your changes in the
Editor view. Because cloud projects are always online, you do not need to create packages
for further work on the cloud projects.

About this task
However, you can download cloud project files to work offline, in the following workflows:

• upload package offline in Trados Studio. This workflow is especially if you are working
with Trados Studio 2017. This Trados Studio version that can open cloud projects but do
not include the Open in Studio option.

• upload offline cloud packages to a third-party CAT tool that support Trados Studio
.SDLPPX packages.

• publishing cloud packages on an Trados GroupShare server.
To download cloud project packages from your cloud account:

Procedure
1. Select your active cloud file tasks that you want to add to a package.
2. Click More Actions > Download Package > Split Package. You can choose to split this

into a specified number of packages. The number of files to be included in each package
will be displayed based on the number of packages specified.
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3. Upload the downloaded .SDLPPX package into Trados Studio or a third-party CAT tool,
translate the files, then create a return package to upload back to your cloud account.
This will move the uploaded cloud project files to the Completed stage.

Tracking cloud project status
When working with cloud projects, you can find detailed information on the overall status of
your project, as well as project-specific analytics from the Dashboard and Projects tab:
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If your project is synced with Trados Studio you can also check project progress in the
Manager view, Files view and File view windows:
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Finalizing cloud project files
Generate the target translated files to finalize cloud project files. The Update Main
Translation Memories batch task is not necessary for cloud projects. This is because cloud
TMs are updated in the background when you manually save your changes in Trados Studio
and automatically, when you translate in the Trados Online Editor.

From Trados Studio

Click Batch Tasks > Generate target files (cloud projects) from the ribbon in the Projects,
Files or Editor view.
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From a browser

1. Go to your cloud account and click the Projects tab.
2. Select the project for which you want to download the translated files and click Open.
3. Click Files tab > Download all.
4. From the Download Project Files menu, select the Target Files check box. Download

the latest available translated content in one of the available formats: Current version
(an *.sdlxliff with the latest translated content) or Native version (the native file format
with the latest translated content).

5. Save the *.zip archive and unpack it to get the file.
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5

Manage server projects



Publish local projects on GroupShare
You can publish your local project on Trados GroupShare to share it with other team
members and assign work as necessary.

Procedure
1. Select Publish project on Trados GroupShare. This publishes the project on Trados

GroupShare. For information, refer to the videos and information in the Trados Studio
2024 Help .
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End of Quick Start Guide



Now you know how to create and manage projects in Trados Studio.

For additional information about creating and managing projects in Trados Studio, see the
Trados Studio 2024 Help .

6 End of Quick Start Guide
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Trados Studio includes open source or similar third-party software.

Autofac
Version: 4.8.1

Vendor: Autofac

Copyright: Copyright © 2015 Autofac Contributors

License type: MIT

License details: “https://github.com/autofac/Autofac/blob/v4.8.1/LICENSE”  on page 0

Azure.Core
Version: 1.38.0

Vendor: Microsoft, azure-sdk

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/Azure/azure-sdk-for-net/blob/main/LICENSE.txt”  on
page 0

Azure.Identity
Version: 1.11.1

Vendor: Microsoft, azure-sdk

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/Azure/azure-sdk-for-net/blob/main/LICENSE.txt”  on
page 0

CachedImage
Version: 1.0.1

Vendor: Hari Pachuveetil

Copyright: MIT © Haridas Pachuveetil 2014

License type: MIT

License details: “https://github.com/floydpink/CachedImage/blob/main/LICENSE”  on
page 0

ControlzEx
Version: 4.4.0

Vendor: Jan Karger, Bastian Schmidt

Copyright: Copyright © 2015 - 2020 Jan Karger, Bastian Schmidt, James Willock

License type: MIT

License details: “https://github.com/ControlzEx/ControlzEx/blob/4.4.0/LICENSE”  on page
0
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Crc32.NET
Version: 1.2.0

Vendor: force

Copyright:

License type:

License details: “https://github.com/force-net/Crc32.NET/blob/develop/LICENSE”  on
page 0

DocumentFormat.OpenXml
Version: 2.15.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/OfficeDev/Open-XML-SDK/blob/v2.15.0/LICENSE”  on
page 0

Flee
Version: 1.2.2

Vendor: Muhammet Parlak

Copyright: Copyright 2017 Muhammet Parlak

License type: L-GPL

License details: “https://github.com/mparlak/Flee”  on page 0

HtmlAgilityPack
Version: 1.11.16

Vendor: ZZZ Projects

Copyright: Copyright © ZZZ Projects Inc.

License type: MIT

License details: “https://github.com/zzzprojects/html-agility-pack/blob/v1.11.16/LICENSE”
 on page 0

Hunspellx86
Version: 1.7.2

Vendor: Crawler-Lib

Copyright: Copyright (C) 2002-2017 Németh László

License type: L-GPL

License details: “https://github.com/hunspell/hunspell/blob/v1.7.2/license.hunspell”  on
page 0
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ICSharpCode.Decompiler
Version: 7.1.0.6543

Vendor: Daniel Grunwald, Siegfried Pammer

Copyright: Copyright 2011-2021 AlphaSierraPapa

License type:

License details: “https://github.com/icsharpcode/ILSpy/blob/v7.1/doc/license.txt”  on
page 0

icu.net
Version: 2.9.0

Vendor: SIL International

Copyright: Copyright © 2007-2019 SIL International

License type: MIT

License details: “https://github.com/sillsdev/icu-dotnet/blob/v2.9.0/LICENSE”  on page 0

Icu4c.Win.Full.Lib
Version: 59.1.15

Vendor: SIL International

Copyright: Copyright (c) 2016-2017 SIL International

License type: ICU

License details: “https://github.com/unicode-org/icu/blob/release-59-1/icu4c/LICENSE” 
on page 0

log4net
Version: 2.0.16

Vendor: Cincura.net, Apache.Logging

Copyright: Copyright 2004-2017 The Apache Software Foundation

License type: Apache 2.0

License details: “https://github.com/apache/logging-log4net/blob/rel/2.0.14/LICENSE” 
on page 0

MahApps.Metro
Version: 2.4.10

Vendor: Jan Karger, Dennis Daume

Copyright: Copyright © 2021 .NET Foundation and Contributors. All rights reserved.

License type: MIT

License details: “https://github.com/MahApps/MahApps.Metro/blob/2.4.10/LICENSE”  on
page 0
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Markdig.Signed
Version: 0.31.0

Vendor: Alexandre Mutel

Copyright: Copyright (c) 2018-2019, Alexandre Mutel.All rights reserved.

License type: BSD-2-Clause

License details: “https://github.com/xoofx/markdig/blob/master/license.txt”  on page 0

MaterialDesignColors
Version: 3.0.0

Vendor: James Willock

Copyright: Copyright 2015 James Willock/Mulholland Software Ltd

License type: MIT

License details:
“https://github.com/MaterialDesignInXAML/MaterialDesignInXamlToolkit/blob/v4.3.0/LICENSE”
 on page 0

MaterialDesignThemes
Version: 5.0.0

Vendor: James Willock

Copyright: Copyright 2015 James Willock/Mulholland Software Ltd

License type: MIT

License details:
“https://github.com/MaterialDesignInXAML/MaterialDesignInXamlToolkit/blob/v4.3.0/LICENSE”
 on page 0

MaterialDesignThemes.MahApps
Version: 1.0.0

Vendor: James Willock

Copyright: Copyright 2015 James Willock/Mulholland Software Ltd

License type: MIT

License details:
“https://github.com/MaterialDesignInXAML/MaterialDesignInXamlToolkit/blob/master/LICENSE”
 on page 0

Microsoft.ApplicationInsights
Version: 2.22.0

Vendor: Microsoft

Copyright: Copyright (c) 2015 Microsoft

License type: MIT

License details:
“https://github.com/microsoft/ApplicationInsights-dotnet/blob/v2.2.0/LICENSE”  on page
0
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Microsoft.AspNet.WebApi.Client
Version: 6.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: Apache 2.0

License details:
“https://www.nuget.org/packages/Microsoft.AspNet.WebApi.Client/6.0.0/License”  on
page 0

Microsoft.AspNetCore.Connections.Abstractions
Version: 8.0.3

Vendor: Microsoft, aspnetcore

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.Http.Connections.Client
Version: 8.0.3

Vendor: Microsoft, aspnet

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.Http.Connections.Common
Version: 8.0.3

Vendor: Microsoft, aspnet

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.JsonPatch
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MS-PL

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0
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Microsoft.AspNetCore.SignalR.Client
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.SignalR.Client.Core
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.SignalR.Common
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.SignalR.Protocols.Json
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.Bcl.AsyncInterfaces
Version: 8.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0
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Microsoft.Bcl.HashCode
Version: 1.1.1.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/main/LICENSE.TXT”  on page 0

Microsoft.Bcl.TimeProvider
Version: 8.0.1

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.1/LICENSE.TXT”  on page 0

Microsoft.CSharp
Version: 4.7.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0

Microsoft.Extensions.Configuration
Version: 8.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0

Microsoft.Extensions.Configuration.Abstraction
Version: 8.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0
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Microsoft.Extensions.Configuration.Binder
Version: 8.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0

Microsoft.Extensions.DependencyInjection
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

Microsoft.Extensions.DependencyInjection.Abstractions
Version: 8.0.1

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.1/LICENSE.TXT”  on page 0

Microsoft.Extensions.DependencyModel
Version: 7.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/core/blob/v7.0.0/LICENSE.TXT”  on page 0

Microsoft.Extensions.Features
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.Extensions.Http
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.
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License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

Microsoft.Extensions.Logging
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

Microsoft.Extensions.Logging.Abstractions
Version: 8.0.1

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.1/LICENSE.TXT”  on page 0

Microsoft.Extensions.Options
Version: 8.0.2

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.2/LICENSE.TXT”  on page 0

Microsoft.Extensions.Primitives
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

Microsoft.Identity.Client
Version: 4.60.3

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/microsoft-authentication-library-for-dotnet/blob/4.60.3/LICENSE”
 on page 0
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Microsoft.Identity.Client.Extensions.Msal
Version: 4.60.3

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/microsoft-authentication-library-for-dotnet/blob/4.60.3/LICENSE”
 on page 0

Microsoft.Identity.Client.NativeInterop
Version: 0.16.0

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “”  on page 0

Microsoft.IdentityModel.Abstractions
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/dev/LICENSE.txt”
 on page 0

Microsoft.IdentityModel.JsonWebTokens
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/dev/LICENSE.txt”
 on page 0

Microsoft.IdentityModel.Logging
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/dev/LICENSE.txt”
 on page 0
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Microsoft.IdentityModel.Tokens
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/dev/LICENSE.txt”
 on page 0

Microsoft.Office.Interop.Outlook
Version: 15.0.4797.1004

Vendor: Camron Bute

Copyright:

License type:

License details: “”  on page 0

Microsoft.Office.Interop.Word
Version: 15.0.4797.1004

Vendor: Camron Bute

Copyright:

License type:

License details: “”  on page 0

Microsoft.Web.WebView2
Version: 1.0.2210.55

Vendor: Microsoft, webview

Copyright: © Microsoft Corporation. All rights reserved.

License type:

License details:
“https://www.nuget.org/packages/Microsoft.Web.WebView2/1.0.2210.55/License”  on
page 0

Microsoft.Xaml.Behaviors.Wpf
Version: 1.1.77

Vendor: Microsoft, xamlexperiencesteam

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/microsoft/XamlBehaviorsWpf/blob/v1.1.77/LICENSE” 
on page 0
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murmurhash-signed
Version: 1.0.2

Vendor: Darren Kopp

Copyright: Copyright © 2021 The Apache Software Foundation, Licensed under the Apache
License, Version 2.0.

License type: Apache 2.0

License details:
“https://github.com/darrenkopp/murmurhash-net/blob/master/LICENSE.md”  on page 0

NETStandard.Library
Version: 2.0.3.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/standard/blob/v2.0.3/LICENSE.TXT”  on page
0

Newtonsoft.Json
Version: 13.0.3

Vendor: James Newton-King

Copyright: Copyright (c) 2007 James Newton-King

License type: MIT

License details:
“https://raw.githubusercontent.com/JamesNK/Newtonsoft.Json/master/LICENSE.md”  on
page 0

Nlog
Version: 4.6.7

Vendor: Jarek Kowalski, Kim Christensen, Julian Verdurmen

Copyright: Copyright (c) 2004-2020 NLog Project - https://nlog-project.org/

License type: BSD-3-Clause

License details: “https://github.com/NLog/NLog/blob/v4.6.7/LICENSE.txt”  on page 0

Sdl.MultiSelectComboBox
Version: 1.0.77

Vendor: RWS

Copyright: Copyright © RWS

License type: Apache 2.0

License details: “https://github.com/RWS/Multiselect-ComboBox/blob/master/LICENSE” 
on page 0
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Sharpcompress
Version: 0.36.0

Vendor: Adam Hathcock

Copyright: Copyright (c) 2014 Adam Hathcock

License type: MIT

License details:
“https://github.com/adamhathcock/sharpcompress/blob/0.36.0/LICENSE.txt”  on page 0

SharpZipLib
Version: 1.4.1.0

Vendor: ICSharpCode

Copyright: Copyright © 2000-2018 SharpZipLib Contributors

License type: MIT

License details: “https://github.com/icsharpcode/SharpZipLib/blob/v1.4.1/LICENSE.txt” 
on page 0

SimpleInjector
Version: 5.4.4

Vendor: Simple Injector Contributors

Copyright: Simple Injector Contributors 2010 - 2020

License type: MIT

License details: “https://github.com/simpleinjector/SimpleInjector/blob/v5.4.4/LICENSE” 
on page 0

SmartThreadPool
Version: 2.3.0

Vendor: Ami Bar

Copyright: Copyright © Ami Bar

License type: MS-PL

License details: “https://github.com/amibar/SmartThreadPool/blob/v2.3.0/LICENSE”  on
page 0

System.Buffers
Version: 4.5.1

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/corefx/blob/master/LICENSE.TXT”  on page 0
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System.Collections.Immutable
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.IdentityModel.Tokens.Jwt
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/7.4.1/LICENSE.txt”
 on page 0

System.IO.Abstractions
Version: 4.2.17

Vendor: Tatham Oddie

Copyright: Copyright © Tatham Oddie 2010

License type: MIT

License details:
“https://github.com/System-IO-Abstractions/System.IO.Abstractions/blob/main/LICENSE”
 on page 0

System.IO.Pipelines
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Memory
Version: 4.5.5

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://dotnet.microsoft.com/en/dotnet_library_license.htm”  on page 0
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System.Net.Http
Version: 4.3.4

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://dotnet.microsoft.com/en-us/dotnet_library_license.htm”  on
page 0

System.Numerics.Vectors
Version: 4.5.0

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://dotnet.microsoft.com/en/dotnet_library_license.htm”  on page 0

System.Reactive
Version: 6.0.0

Vendor: .NET Foundation and Contributors

Copyright: Copyright (c) .NET Foundation and Contributors.

License type: MIT

License details: “https://github.com/dotnet/reactive/blob/rxnet-v6.0.0/LICENSE”  on page
0

System.Reflection.Metadata
Version: 5.0.0

Vendor: Microsoft, dotnetframework

Copyright:

License type:

License details: “https://github.com/dotnet/runtime/blob/v5.0.0/LICENSE.TXT”  on page 0

System.Reflection.TypeExtensions
Version: 4.7.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/corefx/blob/master/LICENSE.TXT”  on page 0

System.Runtime.CompilerServices.Unsafe
Version: 6.0.0

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.

7 Acknowledgments

74 Project Management



License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0

System.Text.Encoding.CodePages
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Text.Encodings.Web
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Text.Json
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Threading.RateLimiting
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Threading.Channels
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0
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System.Threading.Tasks.Extensions
Version: 4.5.4

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/corefx/blob/master/LICENSE.TXT”  on page 0

YamlDotNet
Version: 8.1.0

Vendor: Antoine Aubry

Copyright: Copyright (c) 2008, 2009, 2010, 2011, 2012, 2013, 2014 Antoine Aubry and
contributors

License type: MIT

License details: “https://github.com/aaubry/YamlDotNet/blob/v8.1.0/LICENSE.txt”  on
page 0

ZstdSharp.Port
Version: 0.7.4

Vendor: oleg-st

Copyright: Copyright Oleg Stepanischev 2024

License type: MIT

License details: “https://github.com/oleg-st/ZstdSharp/blob/0.7.4/LICENSE”  on page 0
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